| PHOTOSHOP 6.0

sl i

\ x . SRS
&L /4\ = - < XX S
5" , S

| SC 19 ¥ i

.

Soltware

7 =2 0 7 R o ok Bt 4

http://www.xduph.com P




x
=
=
W
M
£
i
Bl




RNy

Photoshop 6.0 2 BRI RSB AMNERLERE, ZREERNAAEHA ZNEA.

Z B3t Photoshop 6.0 317 7 € EAIHRE. £BHSHAE: £—ENA Photoshop 6.0
HFThEE, FEZH-CEFMMIFR TXH. BR. BR. BRSREMNERSEXGS
HIR1E; %/\%E%hﬁzgﬁﬁﬁéiﬁl ﬁ?ﬁﬁﬁ% Fm#ﬂ’]%h ’ﬁﬁﬁTﬁmr‘Fﬁ

ﬁﬁ%ﬁﬁ%&?‘%ﬂﬂ’]ﬁlﬂ?ﬂ&ﬁﬁﬁ#ﬂ’]%ﬁo
AREEFHIFERITBABIYFE,

EPERRE (CIP) ¥iE

Photoshop 6.0 SEISIE / dbst THAME B ME. —75%: TR TRECRE MR, 2000.11
ISBN 7-5606-0951-1

I.P-- I. jte 1. BFEERE, Photoshop 6.0 1V.TP391.41
FEMAEHE CIP JiRE&F (20000 ¥ 55452 5

TEmE BEH B4R

WMARRAT B PR (RHAREHE%25)

B i (0298227828 W 4% 710071

http://www.xduph.com  E-mail: Xdupfxb@pub.xaonline.com
B BeBE -

Rl TR REENR

K 20004 11 A 1LAR 2000 4F 11 358 1 KEDRY

A 787 ZHKX1092 ZXK 1/16 ENFK 225

¥ S34TF

#  1~6000

#r 30.00 7T

ISBN 7 - 5606 — 0951 — 1 / TP * 0862

* % x SNRENREIEAT IR * * *

EBHENHERB STRRAFLRE AR AIRG, TRGE R EHE.

ft 2 HFRER



*®
x

o

b
L

S

LT TR A=

PRE B
®

R

FERIE

Je

?
I/?\

e

W

JEREE 1R W%
T B XEfRE

o RFK
BRE LES
5K SR

ERY



%—& Photoshop 6.0 B9 #rhAE

o BREUBEE e 2
—+ ImageReady 3.0.....c.ccoeenennininiennnn 4
= ORI SIFIEBL e, 5
VU AFAEFTINEE oo, 7
=
=y BWETAERME oo, 12
Ty BRRE RSB 13
Z BRI e 15
L R L 18
T 25 19
VARSI 1152 SN 315" & 21
B XFERIHHATIRIE i, 23
Koy RGN coommmmmnsiimsmmmmis 25
v AEBIIABEZE o, 27
o SEBREFEERTE i 29
Ty BEXEE e, 31
T2 WERESE e, 33

R 2
%4): ImageReady 5 Photoshop #9474%.............ce......... 4
e T L F L 7 I PR 6
FEBl: BAETFTRABRAGBA e 8
X X 3% ¥

4 BEREEKE R TAREXGHE . 12
FH: FIEFETARAL e, 14
FA BB oo 16
FH: BRZADE P oo 18
FA): EGE BT e 20
e L 7 S 22
Fhl: EH R EERER . 23
FH: B BRRT e 26
FH: B BT e 28
FH): EEANBL” oo seeeseeeesesees 30
FH: AR A BREBATHER o, 32
Fhl: BhH AAFHERRE K e, 34

BEF SERGHKRTE

= HHREEREER 38
Ton BUETESE e 40
S XTGP e 42
I R A S 44
Fiy BHBBIE icissnssiammmmmsmsmmmssssnssscsane 46
AN B e, 48
L R e, 50
NG TBEEE e, 52

: 4 RGB B 1§44 % CMYK B14...................... 38
D A EBERE T e 40
D PR BRI EEBE e 42
D AT BRI E T e 44
DR EBYEA oo 46
P BHEBREEAZABBE 48
D RBPEEARGRES T o 50
DOARIAERAA R e 52



v BEBMREE R e, 54 FH: FTRIEEIES et 54
Fo BEFEIT oovveereveen e masereens 56 FA]: BEEEEE oo et 56
FomE X EReH M A
=y HET R s 60 T RTEIBAE oo e 60
T MERERESBARER 62 o T = . OO 62
T REHEEE e, 63 R . O 64
P, BERBET R e 66 FBl: BB e esse e 66
Fiw WD oo 67 T BT et et seees e 68
VAR - 271} 70 Ftl: FBREEGIMP. e 70
Hiv FMEIREALE oo, 72 T R B 1 72
N EXREE L e, 73 T BB ettt ennins 74
e BITTE (o, 75 T T < 76
T, Color Range M1 % oocervverrerenreensresnerenn. 77 FHl: BFEIHE B K ceeceeeeeenserenns 78
B R 31§77 = 81 R T 5 81
N = 2 55 3 SO 84 FB: FETLEIET o ssesssssene 85
EFE B EHEA
=y FBBE s 90 Tt A BE e 90
Z. BBEEIEME s 91 T4 EHABREE e, .92
<) =3 1] OO 93 FTH: BREBEEE e 94
V., BEMBBEERT oo 95 Lo R E . SO 96
BN 2 225 3] = 97 o TR 7 K B OO 98
75y BEBHE e 99 FHl: AEEEEAYER e, 99
o PR ) = SO 101 EHl: BLEFTERTBROARE .o, 101
N REEZEAFERRR 103 T FATEIIRAE v as e seaeies 103
s FEFERER oo 105 B BRI e 105
Fo HFBEE oo 107 T AEFBE et eeesseeesseeon 107
B R A 212 = S 109 FH: AELFEE e .109
T BB e 110 g o - 111
xR R S5RIZEHMA
= TBIEREERERAE o, 114 FH: BB et eeen 114
T HAREREE e 116 Tl SBRBEIRE oot eese e 116
o FRAPUEIES o 118 FW: HABITEE oo 119
PY. B BB e 120 3 TR 2 3 121
fi. BRSEXOHEES ... 122 FB: REEBABEREK e 123

-2-



T KR et ss et 126
Tl BT e 129
T TRRIETHEE e ss e sinsee 133
F A S SHBE et ssssseenes 136

BtE RBEHEA

75y BBREIZEIE oo 126
B MBERBRAR ..o 129
NS RESER AT e, 132
e BRABHIGE oo 135
= BREB () e, 142
Iy BRI () e, 146
ZLBREHE () e 150
PO ZRESE () e 154
A BAREE (B e, 157
75 BERIHEEL () e, 162
T BRI () 165
Ny BREEE () 169
s BREEE () e 172
o BRMIEE (5 e, 176
T HBEE () e 178
T BB (T s 183
+=. HBER (Z) e 187
TP, HMEESE (DD e 190
FH BEFEIEEE e 195
TN BEUIERE () e 198
Tt BEUEE (Z) e 201
FI0 BEREE () e 204
T EREE (5 e 209
Ay BB e 212
T ZEREE (&) e 215
AL BEEE (D) e 218
T BEEE (5) e 223
AU, LEES () s 226
TR SEEEE (D) e 229
ZAAR R (—) 232
T, KA () 237
AN BEEE () o 241
T BB () s 246
S BAREEEE () 251
Zepees HABEESE () 254

: BEBE. T, FEERF e, 142
T BRAHE. B3, BREEE. 147
Rk BB HEERB. ., 151
: BHEE, B ARER. 155
C . WEEE. KEEERE. . 158
D AR SMAEM. SHAEMER. 162
2 RSP, ATERARMIRHE 166
D BALAR. ERHEMAARERAYESR. ......... 170
D BEM. TR, BAEM. 173
D RBRERNSEFEREB e, 176
DRI, BE. BEER e, 179
D OB R BARAFER ., 183
M. B, LR 188
DoARA. R BEEEEe 191
: Wk E . REXR, PERAEH........ 196
: MEFEA. MK SERER....coon 199
T BBRE ., LBERE. BB 201
: ZHER. EZH. BAER . 205
DOTRHMR. SIBHEAEB ., 210
DB, BBBUL. B RRBULEK................ 213
D A RS, BERRHSER................ 216
T A% HE, LBRERF.o 219
: FEARE. BRENER. .. 223
AR, FBR, BEERB.c, 226
D S RAFR RARKER 230
TR A FRABE e, 233
D AENRAY. R4E. WK, FUEK.......... 237
DR B BEAFAER 242
T M. A EHIE. SOTM AR 247
: BENL. BRER. AKEREH. ., 251
DAAKBER . A e 255



BNANE EXEHXKFT

TV B (o) sttt ettt b st s e e se e ees s ese e 258
Tov REL (D) ettt s ss st s s s b s e e SR et e et ettt raeeen 259
Zv BRI () s s s R R bt oS bt en e 261
PUL JERBL CIH)  ceeceirenenssaessssesssasssssssssnasssesssssses e bbb e ss s et s sas s ses st b sare s sas s essesssssnssassssesmsesnns 263
TLy JREL () ottt s s st ba s sss s sasss st sss s st st ba st se s est e s esss e eren 264
TNA JERBL (F3) et sisescmssssess s ssssssssssssss s ssass st b b s s a s m s bs b m e 265
oy TREL () et s sttt b st st bbbt R b e p e s sR sttt 268
NS BFRIOUT (7)o sses st sss s sas s s sttt 271
FUs BFRIIETE (D) ettt bt s s s s et Am bbb ettt 272
Fov BFBIIETE () et st bt e RS s s ar R s 273
Ty BERIILT (TU) et resessssasss st e s st s R bR s e e bR s bt r s 276
T BEBIIET (L) e ssssssessssssssessssssssssssssssassssssses s sms s ssme s ses s sess st e s st 278
TE0 BEBIIUTE (FX) ettt iss st st sss bt e n s st e e sttt st et sesenneen 281
FHUL BEBIIUTF (D) ettt s s st ss s st sssss bt bbb e eneenn 282
T I BERIILTE (0D et sass b s b s et ss s b s ettt ees e nr e seen 284
TS BRI (JL) et ss s sassesi s s st e st s s st e m st ss et e nee 286
T BEBIT () s sttt st sttt et 289
TN BRI (1) ettt sssasses st sas e e sssa s sse s s et sn st esesnesse s eseees 291
Iy BEREILTE (D) ettt bbb s et 294
T s BT () ettt ss e ss s b e ee s bt ettt s st 298
T 0 BBBEOUT (U)o ssass s et ss s st s asas st sttt s s sme s 299
T2 BERIOUTE (T et teeeeese st oo sesmessasa st ssa s sesss st se s ssereseees 301
T E BEBIOUT CFTR) sttt saes b ss s sas st bes e srase s e s e se s seeon 303
TP BEBESET: () ettt st ssss bt st s sttt s ses s eeneenen 304
Bt o TR <2 "4 G LD OO OO OO OO OO U 305
TR BEBIOUT (L) e ssas st ssssss s sssssssaaasssass s eserns e 307
BhrZE £ 8 3B
B2 ZIRALIBEE oottt ssssss s ssss s ssar s s esss st eea st s ereenn 310
Tt BT AT oot st ettt s ss s enas et 314
T L (20 - < R OO OU VOSSO OP TR 319
SEBITL: BRI covvvorervnrrrrsnsssssessssssssasesssssssssssessesssssssssssssssss s sassosssssssssmssesess s sesseesesssseennsssssssessessssasessssens 329
TEBITL: T B A e rreennesssserssssssssssssssssessssesessassssssbases s easssstas s eses s ss e eeseeseestoeee s sn et e seseeseeeseessssemesses s eeron 340




Photoshop 6.0 ) 3t %

// FERRE

1. REEK

2. #3344 ImageReady
3.0

3. ReHhiaksE

4. AAEHT A

~

// xF iz 2451

1. BReysE

2. ImageReady 5

Photoshop #47i&
3. MEHEA

4. FAET WA &
B A

~




<2 Photoshop 6.0 SE 51| #0F

—. REER

LI {5 2L Photoshop 6.0 154t 2 fiE
2o EI A AR M R R A
W

PRI R, B R BRI R T
R (% RS . BT R
1% i B P 4% rh ARG A A B R BR
PR b e R s AR MR I B R = —
eI 2 AT ERAE, XA A BRI
KB .

% $¢ “ Image>Extract 7 fiy &, #iii
“Extract” X[iEHE, W 1-1 P (&
“Extract” X EHER ) — ). B RARR

FURHEHERI A T f, 3% 4 I 3E30 RS PT LR
OEHEMI RN, DA E A ST ERAE.

T 5 1% £ “ Extract” SFHEHE H (0 02,
LEXHEHER “Tool Option” H ¥ B IN-e kil )
Rt o sl R i/ gese T SR E SO
ZRCR RN . NSRRI R SF K, MInsege sf,
R E PR R B A R LA s s A RS
AN, MIINEELR A, SRR L I LB
W7, (E ER VR SR LIRS ] NSkl i) 2 4K
VB LG, AT AW A B E R 14
MAELT .

TR EAE RS N, W LA I SE Rl
() RSP ERCE BN, PR AE b R BOK B
T AKREGIEOK, RIG4EB) TR EHE
H (1 AR AN B 40 — AT NS o R LE
IS K BIAR, AT LR T R e %

INZELR AT I AT AR TEHE ()
R T H BT e GEFREEN T RS $abin
LK BN AT e R AR ) . W SR EHUH T,
HBE MG TR S T n 2 X B
H7EHUY . 75 “Tool Option” Hn] LA B 1H
AN P . A RERR B A A

(Red). %t (Green). ¥ (Blue) FlIAth
(Other), EFf “Other” Ja£x 5 th—AEL

B, Mk E cARE R EE R,

X nas X S TR B ) i “Preview”
e, W UAE BIRIER IO BUEE, #d
“OK” #ie4l, SEmREV R . nxd Ui
BIAR#E, TEEBE EEEETEE B
A] LA Bk $8 0F iE HE ¢ View 7 3E Y
“Original” %5 . WLE AT LLFT IF SR Y
1%, AT BL7E BUR (1 B4R L B AT R a2
2. BT LLIEFRXTIEHE ) “Show” A
FEE PR B R 1S SRR, AT
545 “None” (L FHifL, RIUGHEIE
HiEW). “Black Matte” (1550 B A,
“Gray Matte” (1§ 54 K ). “ White
Matte” (3550 E ) Fl “Mask” HH2EL
PG E LR

SR PG R 1 K B R R SN S DX 3G
75 B AR i Bk s H A Fh TR

~ Tool Options
Brush Size:[10 »

Highlight: | 5\-cen -
nzm
I Smart Highlighting
— Extraction ————————————

Channel: {,. . =
[ Force Foreground
Co\ar:‘

— Preview —

Shos: IOriginaI - l
Disphy:lﬂone - ]

[V Show Highlight
¥ Show Fill

A 1-1

| R

7. DZEEBIME 1-2 FrsE G
PRECH K, AT R AR



P 1-2
2. #%$¢ “Image>Extract” x4, WK
1-3 7R

Histogram...

Extract... Alb+Chrl4%

A 1-3
# A 1-4 FrzR i “ Extract” X TEAE,
ER R EG A TEX, 2T TR, A
SULIR S -0 28

 1-4
3. RIS —A T B mzem] L.
FAEAK “Tool Options” H K if % =
W R <) “Brush Size” ¥k “30”, 7t
“Highlight” HiEFEINFEIBI A “Green”
(gffa), Wk 1-5 fis.

— Tool Options

Brush Size:'3g| » I
Highlight: lGreen - I
Fill: I Blue - ]

[~ Smart Highlighting

f1-5
4. EBE B AR P B R
%, Wk 1-6 From.

SRS L T e R

1-6

S BRI AT — 5, SRR DA,
T B 1 PR A R P P U REER X AR
ﬁETiﬁ?@é, | ﬁuﬁ_m F)?is,

K 1-7
5. Ml “Preview” &5, WK,
QR O R R, i “OK” HRHELED 5T
BT 0BG R, LR W 1-8 Bk



o4 Photoshop 6.0 SE i B2

& 1-8
— . ImageReady 3.0

kA Photoshop 6.0 5 K FIHF sUA

RS T W TUEIE R ThRE. filn, e

Ak T & 1TH T HAE R TE K
ImageReady 3.0, 1 fl /' A LUZFAHLAE P
The K KA 2 TR AR B4k

ImageReady /& Adobe 2 ] ¥ — 1™
M, B EERETRMMIT. 7 3.01X
ANfEAH, ImageReady tnit T —L37T)
fe, mYIEIR~FRKHEE, I B AT DA
AN K ) B R AR RE AR [ f R 45 F A R
ikt B (EHbHI4E Rollover %41, 3)
H gif .

28R, Adobe 2 &) FFAE ] B HLEIX P
P iE —iE, TR T P2 % h e
TR T P R e S, X X BRI
PAF LA J7 i :

B, “HNFERIEFERE, T
R A T TR T Mg, o —F
F i RAT “File” 3EHHH “Jump to” iy
A, L, EHE—TKE R, BT DURYE
X P b B A R, RVEHAE —H 2]
BhEX .

B, AUUE FRBERABEK, AT
k4 Fl Photoshop [ Fl /- th e 25 5 ¥ %
§F ImageReady, Adobe K§ —# (1) 5 i

B RGOSR, AR
TEA, AMEgmEbmi. Kk, =M
FAERE, JUPEEAH —EHMZER. B
W2 4, 7& ImageReady " i L #E T
Photoshop ¥F% i T H AR, Wi
TA. wi T A, BEF T A, Option M.
R, e E R mFEAE Photoshop
—#f.

% =, Photoshop 5 ImageReady Bt &1
4V, W1HAE Photoshop Fxd G T —
sefgs i, AR A XSS Bt & R B Image
Ready H. [FFE, WR7E ImageReady /i
Ty, XEBEKtaRBE] Photo-
shop . Fk, ATLAHEIEH LRBE—H
X FR. R, ERXFMIFHRMKR,
Photoshop K] Zh#E73 LAZE(#, {#f ImageReady
[ REAS LG 55 . :

Y EBRETRER, MRTEE
Photoshop 5 ImageReady 2 [AI AT ¥4, 5
BARARE, HHoe)E, HEEERE.

ImageReady 5 Photoshop HJYJ#k

7. Photoshop 6.0 15 K ZE Ak ik 2 In s
THEM TUEI/E ST TN AE, 5 ImageReady
3.0 (ISR IREE A B — MREFKIBE.

2. ImageReady 3.0 &— A IIfETRKHY
AL 5T A 8K, AT Windows FABE
T TR @4, BIREE T, W
B 1-9 s

Varsion 30w134

Causon, Aan Ericksan, Troy Goul

Copurit @ 1936-2000 Mabe Systams carpar st Ak rghs ©
esery
Adabe. the Adob logo and

are trademarks of Adobe Systems Incorparsted



“5—%  Photoshop 6.0 11381 Zh g #§¢

3. HE M Photoshop 6.0 #% i F|
ImageReady 3.0, iﬂ?ﬁﬂ@] 1-10 Frax 4% 4

B 1-10
53— R B ) 7 2 AT “ File>Jump
to” 4, WK 1-11 .

T

Adobe ImageReady 3.0  Shft+Ctrl+M

Bl 1-11
4. K 1-12 Fr/xBEl%4 ImageReady 3.0
) TAES i, wLUE ],
() A S i+ 2 AR

'\" Licensed to: ; ay
Adobe

5 Photoshop 6.0

Starting type engine.

Adobe ImageReady"3.0

vin Hoppe. Jobe Olanen, Mark Verbhurian,
. Tim
e e Wabar e A Koo Gouthar - Barbar

Version 30x134

Copyright ® 19982000 Adobe Systems Incorpor ated. Al rights r

eserved.

Adobe. the Adobe logo and ImageReady are trademarks of Adobe Systems incorporated.
o e iorrr M Imagetinsdy dre & Semarte s i >

K 1-12
5. M ImageReady 3.0 37 L4 3]
Photoshop 6.0 1, J7ikFEIFERZHAT “File>
4, Wk 1-13 PR,

Jump to” iy

Adobe Phatoshop 6.0  Ctrl+Shift+M

Motepad
Other HTML Editor,,.

i
Other Graphics Editor... j

& 1-13

6. Photoshop 6.0 5 ImageReady 3.0 [
B, AMUR TAE S dn EAARAL, o HAE
HAE—AN U Es, e EmBEs —
AN,k 1-14 Bk

B 1-14
7. B 1-14 5K 1-15 BRI E&PITH
F#EE, ERR RS BRI R.

A 1-15

=. BeRBEER

PtaFl sh#E I8 8% & Photoshop 6.0 f) T
WaThee, %IEBERIESEM T A,

BB s A IS B IRHEHER H R 24, B
o3 A% FEAT 5B

Xt il ME 22 31 5 — AN i AE AT Xt
“Collection” #t4T#1E, “New Collection”



oG Photoshop 6.0 S e

S ¥, “Rename Collection” Jy HE iy 4,
“Delete Collection” A MIF%

XA 2 300 () B PR AE S 7 A, B
i New "$i4 a] B @A, #.15“ Rename”
T ) A A, B PR — R
% “Del” w5 HMMER o

xof A HE H b Ok v e S Y
TCAR B EIX, AliEPE 2X2~8X8 L
Ffr, BRAE T AR B R Bh S B A

STAHHER T #B4 “Pattern” 4R il
Wi, a4 i RGB AE i FRIH A B .
SR AE A T FF AR, o R L T
g o

SHEHES A1 =4 TR g WA
FRR I o £EA47 1 (R L B AR SRS Mh (S 5
FHAYAE ik b SR eAR S B E XN T #
AN B .

ST HE AT A P R, AL T hr ik
HEFR AT k4% “Web Safe Palette” (4% %4>
WM B “Load Color Table” (A
B

i FH B Ce B sh A IR G B 2 B R AR R
Y E IO P B, O TEHE A
ETH, A AR AR B
B, RIG7E e P AN AL E ik, B
ZRAR N L TIE s EREE TR
i B TR R R, R s S FE L
TR FH A B N s SRR B TR L
TR PR, W DOR IR . 7E
4K L), KR ZE R BUEA TR E] —
&, AT LA RS BE kR 36

CES 2

7. BR{EAEN] “DitherBox ” JEHL XS &
1-16 [RIEHE X B T 7S o

K 1-16
2. %+ “Filter>Other>DitherBox” iy
A, Wik 1-17 fis . Jeif <33 HH“ DitherBox ”
XFUEAE o

DitherBox. ..
High Pass...
‘Maximum. . ;

Custom... l

Minimum. ..
Offset...

K 1-17
3. & 1-18 4 “DitherBox” X 1iHHE, X}
TR HE 2230 o S 7o A5 I 0y PRI, o ) g 3
KRB AR, AAREX . B5 50
XoF & EAT B B o

Itoleclionz 1

Er—

Kl 1-18
Xof 16 ME 22 3 B B8 — AN B PR HE ) T 0
“ Collection ” #HE 1T #:4E, H i “ New
Collection” JiU ] it —ANGCH4E, Wik 1-19
FiR.



%%  Photoshop 6.0 [{IFT ZhfiE .7

Collectionl ;j
Collection2

New Collection...
Rename Collection...
Delete Collection...

cce | B ]|
B 1-19

XS HEA I R PR, ESL N hr iR
HEFIEHE “Web Safe Palette” (2% %2414
), W 1-20 fis.

 |web Safe Palette

Ve fe

A 1-20
4. MATFEBIER EH R MBI R,
BT “New” $dl, HaE—BNE (b
BTG, P RGB HE, HFHO/EN
Hate, wE 1-21 Fiox.

| Collectiont = R ;%
%] Pattern 1 C axd
55| Pattem 2 :: g :
|| Pattem 3 5 .VF’”?‘

8x8

Corcel | [ 0]

4 1-21
PR E N “8X8”, MM EXRH
HOITH OB, Wik 1-22 FioR.

: IWeb Safe Palette

Pl bl ] ]
i

Kl 1-22
5. 4P A B K s “Fill” (3R
7o) f&E, HEmE 1-23 FraarsCRE .

& 1-23

M. FFfEHHThEE

LA A — KRR 2 M N,
1T - Al 5 38 B 1l AR O 0 B 6 AN
Do SR, MG ESRREAEW, AT
W4 ) B S AN e K, B DA 0 R
AT B, HEGE%)E, HR
B FREAD, Frel, RGN SE
85 2 (8] 3 T R — AN R R
14 it A

b T iENIX—/% 2K, Photoshop 6.0 141
T —HiRAF BB T4, Bl “File” 3
] “Save for Web” 8. NHIX—fy
A5, FLP BinT AR 98 1 SAE o 55T & (1
AL, EFEAN R I a4 77 K i be ],



8 Photoshop 6.0 S5 #(f%

W R P P B & i K . Adobe i T — T
FRUIM “Lossy Gif” (FRkMES) BA,
© AT LUK UG ST RN 10%~50%,
T PG B o B H R ARANAR

HAT “Save for Web” w45, BEIFTH
ERXHEE D, HEEARELUTILED:
Fe bR T RAS . TS 1 DL A B
R4 1 T AR 55

FIXT RS0 T RAKR, X B TR
RN, REfFEssh TR, 48T HRE T
H, BRENMIhAESE 2R L 2 ST
BRMFTHE.

i 1 HE P fee 5 | A H Rt 2 TR B D
T o FERIAMER T, SN2 Y iEE
%, BN RS =F A E 48 77 R E
8. MRE T R ETRE D LA, AT
PLi%# “Original” (JRERHI) “2-Up” (JR
HERMR SARMBK AR, EfEERER
1T 4 B KRR RXIEER N — &S
B, SR/, RABEE. B4,
Brbk, B P AT CAR 1T 5 28 b ik % A 3 1Y
B h.

SR A IR R GBI LA R B
SRl 75 K, I A A B 4R
BORAT P T o 34 i) _ER A T ik
B IR S E4E L & AN e, HrhadE
BTk B 45 45 R0 “ Settings” FHzF1IER
HE, FFE+F Gif # 0B FH B 5
) “Colors” FHIFIFRHE, FTiEHFA KM
JEZRFERER “Lossy” FIRMES. HRET
R, AT B R E R A L A @A,
HHEMmBE KR, HATHAP K “Save
Settings” 14, BXFREMRSF, U&H
JEfER . FEHER ST AR 2 “Image Size”
I AR “Color Table” #ilmM, H
“Image Size” &I AR T &% & BB R
K/, “Color Table” 2 HiHH T i & &
15 rh B A R R LR

A EERE, Bdit LMK
“OK” %51, B e # 1 “ Save Optimized As”
SHEHE, AT RERFIOME.

£ iE T R PR A

7. #%$F “File>Save for Web” x4,
B 1-24 foR, SRR S B LR
B A .

1-24
2. P 1-25 3 “Save for Web” Xfi5HE,
HBRA R RAE 7 R B H) Gif X -

3. BHEGED LTS, "Ll
# “Original” (JRZHMID. “2-Up” (JRMhYE
B “4-Up” (JRERT X5 =F AR K
7550 HEATAFEEER, b 1-26 Frr.



f o

45— Photoshop 6.0 ff1H7 Zh g (g

P4 1-26
4. 127 s “4-Up” W E 1N R
N, JEIE AR R4 fE R S5 R, W LLIE
BRI ARARAF -

K 1-27
5. WOREGE AN, AMETRE, "L
FITFAHEHEA: T M TR, MrhiksEAn
[ o be i, ke 1-28 Fios.

1600%
800%
400%
300%
200%
100%
S0%
25%
125%

Fit on Screen

g 1-28

6. B 1-29 BIRIIRIIEHEA _EA AR
TR, OfFE#s). #HREFETH.

O

e
Q
Z
B 1-29
7. AT FFAHERESA AR TRk,

A LLEFEA R % 7 X S s %, miE
1-30 Fi7s.

& 1-30
8. K 1-31 B R i RXHEHEA (U R A7
X 5 4 LU v B AR «

- Settings: |GIF 128 Dithered ¥ |——(3)-
m ‘ Lassy:'E_E
T
v Transparency 'Matie:r—-z
[ interlaced  Web Snap,:m

K 1-31
9. ki “Settings” FHrFIERAME, ATLA
PR A% 3, Wi 1-32 s,




